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CMX Software HD 3.6 User Manual 

 

Central Management Software (CMX Software HD 3.6) is a total solution for managing LILIN’s 

network products including IP cameras and DVRs.  CMX Software HD 3.6 contains (1) network 

video recording software, (2) eMap Manager, (3) Database Manager, (4) Web Server, and (5) 

Remote DVR playback and file download. 

 

Major features including unlimited H.264/JPEG IP cameras and DVR’s cameras recording, remote 

DVR video playback and file download, and camera groupings with user authentication are 

integrated within one system application.   

 

One important feature of eMap is the central management system for live monitoring, alarm 

snapshot management, and map management.  IP devices installed at different locations can be 

represented and managed by using maps.   

 

Circular recording, schedule recording, individual HDD recording configurable, and individual 

camera recording configurable provide the flexibilities in managing recording storages.  CMX 

Software HD 3.6 is designated for hybrid solution for IP camera, video server, IP Fast Dome, and 

DVRs.  It provides total solutions for digital surveillance.  Major features are: 

 

CMX Software HD 3.6 Main Features 

1. Record and manage unlimited channels of H.264/JPEG HD IP cameras or DVR’s 

cameras. 

2. Scheduling, continuous, and motion detection recording supported 

3. eMap live video with alarm snapshots 

4. Integrated alarm management for alarm output 

5. Web server for live video 

6. iPhone and Android phones support 

7. Retail and transportation business solutions 

8. Device grouping and recall 

9. IP Fast Dome control 

10. Export recorded video to AVI file format 

11. Easy-to-use calendar and time selections for video playback 

12. User access levels configurable for groupings and features 

13. Complete operational event logs 

14. Two-way audio and audio recording 

15. Digital zoom, device ePTZ and ROI supported 

16. Dynamically video channels swapping with mouse drag-and-drop 

 

Copyrights 

Merit LILIN Enterprise Co. Ltd. holds exclusive ownership of the software and all intellectual 

property rights embodied therein, including copyrights and valuable trade secrets incorporated 

in the software's design and coding methodology.  The software is protected by international 

treaty.  This agreement provides you with only a limited use license, and does not grant you 

any intellectual property rights in the software. 

 

Adobe and Acrobat Reader are either registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries. 

 

Windows, Windows 2000, Windows XP, Windows Vista, and Windows 7 are registered 

trademark of Microsoft Corporation in the United States and other countries 
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General Notations 

The terms of IP-based devices or products used in this document refer to H.264 HD/JPEG IP 

Fast Domes, Video Servers, or IP Cameras.  The terms of DVR devices/products refer to DVR 

3 and 5 series. 

 

Before Using CMX Software HD 3.6 

CMX Software HD 3.6 contains video recording.  CMX Software HD 3.6 supports 

multiple hard disk drives recording.  If overwritten setting is enabled, the oldest 

recorded video clips get deleted first.  If you want logical partitions in your hard disk 

drive, please setup at least 20 GB for each drive.  To setup hard disk setting, please 

click on “System Setting” button.   

 

Select recording hard drives for CMX Software HD 3.6 

recording.  To enable HDD overwritten option, please 

check this option. 

 

Furthermore, each logical HDD drive should contain at least 

10% empty space for storing video data.  CMX Software 

HD 3.6 deletes the oldest files first until it reaches 90% of 

the logical drive, and it proceeds to the next logical hard disk 

drive for recording. 

   

On-line User Manual 

CMX Software HD 3.6 adopts Acrobat Reader for its on-line manual by clicking on “Windows-> 

Merit LILIN CMX HD 3.6->User Manual”.  You must install Acrobat Reader before opening the 

on-line manual. 

 

Uninstall CMX HD 3.6 

To uninstall CMX HD 3.6, please select Start->Program Files->Merit LILIN CMX HD 

3.6->Uninstall.  A user might want to export the database.  Re-import the database after new 

installation.  Please see Database Manager for detail. 

 

Using CMX Software HD 3.6 on Windows Vista and Windows 7 platforms 

When you install CMX Software HD 3.6 on 

Windows Vista and Windows 7 platforms, 

please go to control panel->User Account 

Control Setting and low the setting to Default.  

This can make sure that CMX can login 

automatically when watch dog performs 

system reboot. 
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Chapter 1.  Using CMX Software HD 3.6 

To access CMX Software HD 3.6, follow these steps: 

1) Click on CMX Software HD 3.6 via Start->Program Files->Merit LILIN CMX Software 

HD 3.6->CMX Software HD 3.6. 

2) Click on CMX Software HD 3.6 on desktop. 

 

To login CMX Software HD 3.6, please follow these steps: 

Step 1.  Select a user from User name dropdown list. 

Step 2.  Type the password or leave it blank if you are first time to use this software. 

Step 3.  Click on OK button. 

 

 

 

Chapter 1-1.  CMX Registration 

To get full features of CMX and 72 channels support, visit 

http://www.meritlilin.com/en/support.asp for CMX registration.  An 

unlocking key will be sent to your email account after registration.  Click 

on Help button for registration. 

 

   

Provide email address and unlocking key to get full features access.  

 

Note: The default passwords for all users are empty. 

http://www.meritlilin.com/en/support.asp
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Chapter 1-2.  System Settings 

System settings contain HDD settings, device settings, and grouping settings.  

Please finish System Setting before operating CMX Software HD 3.6. 

 

 
 

 Auto run this application when system starts:  

CMX Software HD 3.6 auto-run when Windows starts 

 Auto sequence after reboot:  

Perform grouping sequence after system reboot. 

 Full mode after reboot:  

Perform full screen mode after system reboot. 
 Original video resolution at full screen mode:  

Use original resolution at single channel view mode.  Do not scale original video. 

 Auto login when system starts:  

Bypass login when system starts. 

 Default grouping:  

Set default grouping at start-up. 

 Auto minimized when system starts:  

CMX runs in the background when system starts. 

 Default grouping:  

Set default grouping. 

 Default window division:  

Set default window division at start-up. 

 To enable circular recording, please check HDD Overwritten option.  To select HDDs 

for recording, please select HDD(s) for recording in HDD Information list box. 

 System reboot:  

enable the system to reboot every day at certain time. 

  Language:  

To choose language setting, please select your language from Language combo box. 
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Chapter 1-3.  Add a New Device 

To add a particular device, please first select the channel and click on “Property” 

button for adding a new device.  The “Camera Settings” dialog box shows up.  

Please type at least, IP/DNS address, port number, username, and password for 

connecting the live video of the device.  You can also click on “Find Device” and 

selection one device from the IPScan tool.  Click on “Detect” button for detecting the device 

type. 

 

To edit Camera Setting dialog box, please right mouse click on a channel and select Camera 

Properties menu item.  

   
1. Name— camera name which is displayed on top of live video channel 

2. Location—indicating the location of the camera installed. 

3. Frame rate—frame rate for the device 

4. Device type—device type selection box, RTSP is for H.264 D1 or H.264 HD IP cameras. 

5. Enable recording—enable or disable recording for the device 

6. IP/DNS (required)—the IP address of the device 

7. HTTP Port number—the HTTP port number of the device 

8. Video Port number—DVR’s video port number/IP camera’s RTSP port number 

9. Username—the username which is allowed to login the device 

10. Password—the password for the username 

11. Image size—the source video size of the device 

12. Camera/485 ID—IP Fast Dome RS-485 ID. 

13. Synchronize Time with PC—Synchronize time with the remote PC.   
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If the above settings are done, you can click on Connect button to test if the device is properly  

For default username and password information, please see appendix for detail. 

 

Chapter 1-4. Device Type  

There are few device type drivers for connecting streaming:  

 

RTSP—Connect an IP camera with RTSP streaming 

protocol.  

DVR/NVR-JPEG--Connect a DVR/NVR by MJPEG protocol.  

DVR/NVR-H264—Connect a DVR/NVR by H.264 protocol.  

CMX-JPEG—Connect a CMX by MJPG protocol.  

Low Bitrate IP Camera—Connect an IP camera by low 

bitrate protocol.  

Low Bitrate DVR Camera--Connect an IP camera by low 

bitrate protocol.  

Looping Camera—For demonstration purpose, you can 

choose Looping Camera at Device Type selection box for 

duplicate video channel without physically connecting to an 

IP camera or a DVR’s camera. It can reduce bandwidth for 

the network video.  

    

Chapter 1-5.  ONVIF Setting 

To use RTSP streaming, please first setup ONVIF protocol.  The detail setting of ONVIF is 

described as below: 

  

 Profile: a user can select different streaming profile such as H.264 720P or JPEG 720P. 

 Protocol: streaming protocol such as RTP/UDP, RTP/TCP, or RTP/TCP/HTTP. 

 Quality: compression quality 

 Brightness: brightness setting of the video 

 Saturation: saturation setting of the video 

 Contrast: contrast setting of the video 

 Sharpness: sharpness setting of the video 

 Frame rate: change frame rate setting of the IP camera. 

 Bit Rate: bit rate setting of the video 

Note: 1. RS-485 camera ID (1 to 128) must match the ID setting of the IP Fast Dome.  The 

software may not control PTZ movement if the ID setting is incorrect.   
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Chapter 1-6.  IPScan Utility 

To find out the network devices, IPScan utility can scan through all IP address within LAN. 

 

A user can select a device item in IPScan and click on Close button to setup the device.  All the 

device information such as IP address and port number get automatically carried over CMX 

Software HD 3.6.  Click on Connect button in the device dialog box which can test the 

connection between the PC and the device.   

 

You can also manually add devices information of IP Fast Dome/IP camera/video server/DVR  

Note: IPScan can only work under LAN environment, not Internet environment. 

Note: ONVIF setting can only be supported by LILIN’s ONVIF camera. 
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Chapter 1-7.  Alarm Input Management 

There are various alarm inputs that are supported by CMX.  The details are explained below: 

 

 Remote Alarm In: Receive a digital input (DI) alarm from a remote IP camera. 

 Remote Motion Detection: Receive a motion detection alarm from a remote IP camera 

or the camera of NVR/DVR.  This can further save CPU usage of CMX. 

 Remote Face Detection: Receive a face detection alarm from a remote IP camera with 

face detection feature built-in. 

 Remote Tampering Detection: Receive a tampering alarm from a remote IP camera 

with tampering detection built-in. 

 External IO: Receive an alarm from Ethernet APG cash drawer or remote Ethernet IO 

device. 

 Motion detection: CMX’s local motion detection.   

 Video Loss Detection: If the video loss detection is detected, this can trigger Play 

Sound and Send Email for alert purpose.   

  

 

 

Chapter 1-7-1.  Ethernet Digital I/O Device  

Ethernet I/O device such as Moxa ioLogik E1212 can be linked to an IP camera for extern alarm 

input and output device.  Ethernet digital I/O device is used, if the camera does not have DI/DO 

built-in.   

 

Map to the logical digital input and 

digital output for an IP camera. 
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Click on device scan which can find Moxa I/O device on the network.  Once 

one the IP address is selected, please map the logical digital input (DI) or 

logical digital output for an IP camera.  To activate digital output (DO), click 

on Alarm On or OFF button. 

   

 

 

Chapter 1-7-2.  Remote IP Camera with Digital I/O  

If an IP camera has DI/DO interface, enable Remote Alarm In (DI) in the 

alarm input list.  To enable alarm output, click on Alarm On or OFF to 

trigger the digital output via the IP camera. 

    

Chapter 1-8.  Alarm Output Management 

For motion and remote motion alarm detection management, the alarm output feature allows 

various reactions after receiving an alarm.  The alarm output includes (1) PC alarm sound, (2) 

send JPEG email snapshot, (3) recalling a PTZ preset, (4) triggering a DO output for an IP 

camera, (5) alarm full screen, (6) pre-alarm and post alarm.  Please select the alarm output 

from the selection list to enable the option. 
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Chapter 1-8-1. Alarm Sound Alert 

To select pre-recorded alarm audio, click on Alarm Audio button for choosing the WAV file.   

 

Chapter 1-8-2. Alarm Redirects to a PTZ Preset 

If an alarm gets fired, it can redirect another IP camera’ preset for a video. 
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Chapter 1-8-3. Alarm Redirects an IP Camera’s Digital Output  

Once an alarm gets fired, it can redirect the signal to another IP camera’s digital output. 

 
 

Chapter 1-8-4. Re-alarm & Post-alarm 

Re-alarm and post-alarm recordings are triggered by an alarm event.  The recording period is 

based on Pre-alarm and Post-alarm dwell setting.  Pre-alarm & post-alarm can further save 

recording storage.  The video get recorded for a period, after an alarm gets fired.  
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Chapter 2.  Recording Settings 

CMX Software HD 3.6 is configured as continuous recording after an IP camera is connected.  

To change recording configuration, please follow the following selections. 

 

Chapter 2-1.  Schedule Recording Settings 

CMX Software HD 3.6 can schedule recording based on “Always”, “No Record”, and 

“Motion recording for a particular hour.   

 

To enable recording for a particular hour, please click on the week control and set the recording 

option for the hour.  Please also specify the recording type by selecting one of the recording 

types. 

 

To enable recording schedule for all hours, please click on Apply button for “Apply All Schedule”. 

 

To apply the recording settings for all cameras, please click on Apply button for “Apply Schedule 

to All Channels” 

 

 

Chapter 2-2.  Motion Detection Recording 

To enable motion detection recording, please click on camera “Property” button to 

enable “Camera Settings” dialog box.  Once the IP camera is configured properly, 

please click on “Video” button to test the video streaming.    

 



- 15 - 

 

 

Please click on “Motion” button to setup motion detection.  There are up to four motion areas 

available for a user to configure.  Perform mouse-dragging on the video area to define a motion 

area.  Perform right-mouse click can clear a area or clear all areas.  To change motion 

detection sensitivity, please click on the scroll bar for adjust.   

 

 

 

At live monitoring mode, if a motion detection is triggered, the camera window shows “little man” 
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to indicate a motion detection event.  

 

For remote motion detection, please select “Remote Motion Detection” option and “Option” 

button to configure motion detection zones.  Remote Motion Detection dialog box shows up.  

Click on the motion grid area and perform mouse-drag on the grids to define motion detection 

zone.  Make sure Motion Detection check box is enabled.  Click on Apply button that the 

configuration gets download to an IP cameras.      

 

 

 

 

Chapter 2-3.  Recording at System Startup 

After the restart of CMX Software HD 3.6, CMX Software HD 3.6 starts recording automatically.  

There is no need to restart recording service.  If a schedule is set, CMX Software HD 3.6 

records video based on the schedule at startup.    

 

Chapter 2-4.  Estimated Recording Days  

After system installation, to estimate approximate recording days, a user can click on 

System setting button to enable system dialog box.  Click on “Record time” tab.  

Estimated recording day and time information gets shown on the dialog box. 

 

Note: The use of Remote Motion Detection can further reduce the CPU load of a CMX PC,   

since it utilizes the motion detection engine of an IP camera. 
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Chapter 2-5.  Network Storage 

For recording over network storage such as iSCSI or NAS storage, a user can configure CMX 

Software HD 3.6 to record the video to the network storage, if the network storage supports 

“Network Neighborhood” protocol. 

 

 

 

To do so, please first select a drive at “Add Network Drive” list.  Select network storage by click 

on “Mapped Drive of CMX PC” button.  Once the network storage is selected, click on Apply 

button.  At the last, please check the newly added network storage from Drive Number for 

enabling the storage.  CMX Software records video based on the selected drivers at circular 

recording basis. 
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For "Map Network Drive", please make sure that "Reconnect at logon" option is checked.  This 

can avoid losing connectivity from CMX due to network driver rebooting.  

 

 
For adding a network driver for CMX, please select one of the PC HDD or network HDD. 

Perform right mouse click on the HDD.  Click on "Map Network Drive." menu item.  "Map 

Network Drive" dialog box shows up.  This can add the network storage into the CMX’s storage 

drive. 
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Chapter 3.  Grouping Settings 
A user may want to manage camera or DVR groupings based on their geographic 

locations or their functions.  The video of the grouping devices can be recalled 

easily later on.  To setup groupings, please click on the Grouping button and follow 

the followings steps.   

 

1. Select left IP Cam/DVR grouping and select right grouping item.  Click on Right button 

to create a grouping. 

2. Click on Up or Down button to change the sequence in Grouping tree view.  

3. Click on Apply button for the grouping settings. 

 

 

 

Once the groupings are set, a user can switch to different grouping view quickly.  

 
Chapter 3-1.  Grouping Name 

A user can assign a name for a grouping.  To assign grouping name, please right click on a 

grouping, or select on a grouping and click on Property button for its name.  Type the grouping 

name in Grouping dialog box.  
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Chapter 3-2.  Grouping’s Devices 

Once a grouping is set, please select the device of the grouping.  Right click on the 

pre-assigned grouping device item.  Select on the device item and perform right mouse click 

for assigning Property.  

  

Chapter 3-3.  Grouping Authentication 

To assign a grouping access right, please right click on a grouping and select Property menu 

item.  It shows a Grouping Access dialog box.  The default setting of a grouping allows every 

user to access.  To disable access right, please uncheck a user access right.  Grouping 

access right also applies to web server.  Only groupings assigned to a user can be seen by the 

user after login to the web server. 

 

 

Chapter 3-4.  Recall a Grouping 

To recall a grouping, click on grouping drop down list.   
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Chapter 3-5.  Grouping Sequence 

In grouping tab, please specify Sequence Time.  In live monitoring mode, please click on SEQ 

button to perform Sequence Display feature. 

 

 

Chapter 3-6.  Main Grouping 

Main Grouping refers to CMX Software HD 3.6’s main screen which contains 36 

windows-division screen.  To add a device for the main grouping, please follow the steps: 

 

(1) Select Main Grouping in grouping dropdown list.   

(2) Right mouse click on one of the cameras. 

(3) Select Camera Properties to assign the camera properties.   

 
Alternatively, a user can add devices into Main Grouping at System Settings->Device Settings.  

Device Settings allows a user to manage up to 36 channels of IP cameras, video servers, and 

H.264 HD IP’ cameras.   

 

 
 

Chapter 3.7.  Window-divisions 

Currently, CMX Software HD 3.6 supports four types of window-division including maximized 

window (each view), 4-window-division, 16-window-division, and 36- window-division.  To see 

the maximized camera window, you can select particular camera window and click on Each 

View button.  You can also double-click on the live video for the maximized window.  To see 4-, 

16-, and 36-window-division, click on the window-division buttons. 
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Chapter 3.8.  Dynamic Video Channel Editing 

If a user wants to change the arrangement of a camera channel, the user can drag a camera 

and drop to another video channel.  This operation swaps these two cameras’ positions 

dynamically in software.  There is no need to re-assign all the IP settings, if the user later 

changes his/her mind for the camera’s display position after installation. 

 

  

 

Chapter 3.9.  Digital Zoom 

To perform digital zoom, please first drag on the window for digital.  Once the channel is in 

digital zoom mode, please select the green area for other region. 

Drag-n-drop 

Each view 16-window-division 

w 

4-window-division 

w 

36-window-division 

w 
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To perform digital zoom in playback, please follow above procedure. 
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Chapter 4.  CMX Software HD 3.6 Video Playback 

CMX Software HD 3.6 can perform video playback task for all IP-based products including 

H.264 HD IP Cameras, full D1 IP Cameras, IP Fast Domes, Video Servers, LAN Cameras, and 

DVRs.  To perform video playback on various IP devices, follow the following sections:     

 

Chapter 4-1.  Playback 

To perform playback operation, you have to select a camera channel or a DVR.  By 

clicking on playback button, the playback dialog box shows up.   

 

Based on a DVR device or an IP camera device, each device of the playback operation is 

described in the following sections: 

 

 

Chapter 4-2.  Playback for a IP Camera within the Main Grouping 

For the main grouping, the video can be recorded at a local 

PC.  To retrieve stored video clips, playback operation 

can be performed based on date and time specified.  

Please follow the following steps to play video clips on the 

PC: 

 

Step 1.  Click on the date on the calendar control. 

Step 2.  Specify starting time and ending time. 

Step 3.  Click Search button to search the video clips. 
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Once a video clip is playing, click on Stop, Play, Pause, <<, >>, and snapshot buttons for the 

video clip.  A user can also click on the time-bar for video playback.   

 

Chapter 4-3. Multiple Channels Playback  

A user can select a grouping for multiple channels playback.  To do so, please click 

on multiple channels’ playback button.  A playback dialog box shows up as below:  

 

 

 

There are up to 36-channels playback that is available in the system. Please specify date and 

time. Perform Search button for playback task. 

 

For multiple channels playback, the setting shows (1) CMX I frame only (2) I frame only.  

CMX I frame only is when multiple channels playback is activated.  The background 

CMX shows 1 frame/sec for reducing CPU load.  This setting is recommended to be 

checked.  I frame only is for multiple channels playback showing only 1 frame/sec to 

avoid CPU usage.  This setting is recommend to be unchecked if CPU usage is low.     

Alarm Recording Continuous Recording 
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Chapter 4-4. Remote CMX Multiple Channels Playback  

A user can perform playback on a remote CMX for its video recording.  To do so, 

click on "Remote Playback" button. Click on "Connect" button and enter IP/DNS 

address, port number, username, and password for accessing the CMX.  Select a 

grouping for multiple channels playback. 

 

 

 

Chapter 4-5.  SmartSearch 

In CMX multiple channels mode, SmartSearch is supported for quick video search in which 

motion detection zones can be defined for an instance of the recording. 

 

To use this feature, enable full screen mode for a particular camera.  Select SmartSearch 

option from “Select Mode” option.  A SmartSearch gets prompted; drag the motion area on the 

video of the SmartSearch dialog box.  Click on Start button can start to quick scan through for 

Note: Uncheck I frame only for higher frame rate display for smooth video while playback.  

Connect Button 
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the motion activities of the recordings. 

 

The snapshots of the motion activities get displayed in the 

event list.  Click on the snapshots that can quick play the 

video for a particular event. 

 

Chapter 4-6.  Remote DVR/NVR Playback 

For playback on a remote DVR/NVR, please first perform 

right-mouse click on a DVR/NVR channel.  Select 

“DVR/NVR Remote Playback” menu item for DVR/NVR video 

playback. 

 

 

The DVR/NVR Playback dialog box shows up.  Specify date 

and time information in the dialog box for remote DVR/NVR 

playback. 

Drag on the video for 

SmartSearch zones 
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Chapter 4-7.  Remote DVR/NVR File Download 

To download remote DVR/NVR’s files, please first perform right-mouse click on a DVR/NVR’s 

channel.  Select “DVR/NVR File Backup” menu item.  A DVR/NVR File Backup dialog box 

shows up.  Specify date, time information, and click on Search button.  It can list all the files of 

the DVR/NVR.  For downloading the files, please click on Save Folder button and click on 

Download button for downloading the files into a specific folder. 

 

Chapter 4-8.  AVI File Exporting & Play From a File 

 Exporting AVI with OSD 
To export an AVI file for main grouping device, please perform playback operation for the device.  

Once the video clips have been located, specify the file name and click on Save Now button for 

the AVI file. 
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Exporting AVI without OSD 

For direct exporting H.264 AVI file without OSD time stamp, this operation performs fast than 

rendering OSD.      

 

CMX Software HD 3.6 video clips are stored in a hard drive’s Video folder followed by a GUID 

folder.  The GUID folder is a 32-digit hex folder.  CMX Software HD 3.6’s video clips are stored 

as in the folder under year, month, day, hour, and minute.  To retrieve a particular a file, please 

locate the file by the button of “Play from a File”.  

 

 

 

Chapter 4-9.  Multiple Channels Backup 

Multiple channels backup feature can be done for (1) multiple channels playback by 

the player, MPlayer, (2) multiple AVI files for both local and remote backup. 

 

To do so, click on Backup button and selection channels.  Specify date, time, and 

destination directory.  Finally, choose Start Backup or Covert AVI button for multiple channels 

video backup. 
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Chapter 4-10.  Snapshot 

For IP-based devices, you may want to capture a particular video into a picture.  You can click 

on the Snapshot button.  The picture is exported to a JPEG file format.  For DVR devices, 

please perform right-mouse-click and select “Save As JPEG” menu item. 

 

 

 

Chapter 4-11.  Alarm Event Playback 

To playback based on motion detection events, please click on the alarm radio button at the 

Playback dialog box.  Click on Search button to list all the motion detection events.  Click on a 

motion event can play associated video. 
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Chapter 5.  Audio 

Chapter 5-1. Two-way Audio 
To perform two-way audio, please first select a particular channel for listening to the audio of the 

channel.  Click on Speaker icon to enable audio feature.  To change volume, please change 

volume bar.   

 

 

To speak to remote site, please click MIC On button.   

  

To enable audio monitoring, please double click on a channel in full screen mode for audio 

monitoring.   

 

Chapter 5-2. Two-way Audio Auto Switching  

CMX Software HD 3.6 supports two-way audio for IP cameras.  Enable "Audio Auto 

Switch" button which allows automatically speaking to remote site and listening to 

the audio, when the camera is triggered by the remote IP camera’s digital input.   

 

 

 

Chapter 5-3. Audio Recording  

For IP cameras with audio input models, CMX Software HD 3.6 can record audio with its video. 

To listen to the audio recording, playback feature can play the audio. 
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Chapter 6.  Archiving Manager  
CMX Software HD 3.6 Archive Manager can archive video to a central network storage.  

Archive Manger is located in each CMX PC.  It can perform video clips archiving to the central 

storage automatically.  

 

 

Chapter 6-1. Archiving Source  

To perform video archiving, select the cameras for video archiving.  You can keep the video 

clips from the CMX PC (Duplicate Archiving), remove the video clips from the CMX PC, or 

choose the time not for archiving.  After configuring above, you can schedule the archiving task 

starting at specific hour of the week of the camera or apply all for the schedule to other cameras.  
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Chapter 6-2. Archiving Destination  

A user can choose the Archive Driver for archiving the video clips from a CMX. The Archive Drive 

could be a network RAID drive or internal SATA RAID for large among data.  For a network 

RAID (NAS), click on "Setup Network Disk" button to attach the drive to the CMX.  After setting 

up the archiving drive, select Real-Time Archiving or Scheduled Archiving.  For the Read-Time 

Archiving, the archiving task is activated in the next minute.  After the configurations, a user can 

click Start button for archiving task. 
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Chapter 7.  User Settings 
User setting allows add a user, delete a user, change password for a user, and assign feature 

accessed by a user.     

 

To add, delete, and modify a particular user, click on User button in NVR tool box.  

 

The User Setting dialog box shows up. 

 

 

Chapter 7-1.  Add a User 

To add a user, click on a particular user in the user list and click Add button.  Add User window 

shows up.  To add user, specify user name, password, and confirm password.  Please also 

specify the user level and click on OK button. 

 
 

Chapter 7-2.  Modify an Existing User 

To modify an existing user, click on a particular user in the user list and click Property button.  

To modify the user, specify user name, password, and confirm password.   

 

Chapter 7-3.  Delete a User 

To delete a user, please select the user in user setting window and click on OK button. 

 

Chapter 7-4.  User Authorization 

Features of CMX Software can be assigned for a user.  To enable a feature for the user, please 

first click on Property button.   The User Property dialog box shows up.  Click on the check 

box for the user in Access Level list item. 
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Chapter 7-5.  Alarm Email Notifications 

For sending alarm email notifications, please configure the email setting in the user.  After 

finishing email setting, please configure Alarm Output Management at Camera Settings. 
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Chapter 8.  PTZ Control Panel 

In order to perform PTZ movements, you have to select a particular live channel which contains 

an IP Fast Dome.  Once an IP Fast dome is selected, you can control the movements using PC 

keyboard and/or PTZ control Panel. 

         

Chapter 8-1.  Preset Point Settings 

To setup preset points, please invoke Presets dialog box.  Follow the following steps: 

 

Step 1.  Select preset point dropdown list. 

Step 2.  Type the time field. 

Step 3.  Type the speed field. 

Step 4.  Click up, down, left, or right to move the IP Fast Dome to specific position. 

Step 5.  Click Apply button to set the position. 

 

 

Chapter 8-2.  CMX Software HD 3.6 Status Panel 

CMX Software HD 3.6 status panel is described as following chart. 

PTZ control 

IRIS control 

Focus control 

Speed control 
Zoom control 

control 

Auto pan 

control 

Preset settings 

Preset points 
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Chapter 8-3.  Control PTZ via PIH-931D Keyboard 

To use PIH-931D keyboard for CMX, please follow the following steps.  First, please add a 

RS-232<->RS-485 convertor for connecting PIH-931D keyboard and a CMX PC.  

 

Chapter 8-3-1.  DVR Control Mode 

Press the SHIFT button and the DVR button to set the keyboard to DVR control mode. 

 
+  

 
 

To control a CMX, please first enter the DVR ID (CMX ID) follow by the ENT button. 

 
+  + 

 

To recall a grouping, please type 1 + MON and following by grouping ID and the PRESET 

button. 

 
+ 

 
+  +  

Chapter 8-3-2.  Window-division 

To change window-division, please first control a CMX and type the following buttons. 

 

 
16-division 

 
8-division 36-division CMX ID + DVR + ENT 

 
9-division 

 
4-division   

Recording percentage of HDD  

System date 

System time 

Sequence mode 

CPU usage 

RS-232<->RS-485 Convertor 

Speaker status 

MIC status 

User status 
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To recall 36-window-division, please type CMX ID followed by DVR and ENT buttons.  The 

operation is same controlling a CMX. 

 

Chapter 8-3-3.  Recall a Camera 

For recalling a camera, please select camera number and follow by CAM button. 

 

Example: Call camera #8 

 

 

 

 

Zoom in 

 

Zoom out 

 
Tilt up 

 
Tilt down 

 

Pan left 
 

Pan right 

  
Zoom in 

 
Zoom out 

  
Focus near 

 
Focus far 

 
IRIS small 

 
IRIS large 

 
Auto Pan   

 

Chapter 8-4.  IP Camera ePTZ or ROI Feature 

For some IP cameras, they provide ePTZ or ROI feature.  A user can still use the keyboard 

controller for ePTZ or ROI feature via CMX Software HD 3.6.  

 

Chapter 8-5.  Switching in Between CMXs and Virtual Matrix Monitors 

Please first gain CMX access by press SHIFT button and DVR button. 

 
+ 

 

To control the CMX, please type CMX ID, DVR button and ENT button. 

 
+  + 

 

After a CMX gets controlled, a user can address the monitors of the CMX.  

 +  +  



- 39 - 

 
+ 

 

To control #5 monitor, please click 5 button + MON for controlling #5 CMX monitor. To recall a 

grouping, please type the monitor ID + MON and following by grouping ID and the PRESET 

button. 

 

Chapter 8-6. Keyboard Playback  

Please press SHIFT and DVR buttons for playback a CMX and press one of the follow buttons 

for playback. 

To control multiple channel playback feature, please click on Stepping Forward button. This 

invokes multiple channel playback features. 

 

To control multiple channel playback feature, please click on Stepping Forward button.  

This invokes multiple channel playback features. 

 

To control single channel playback feature, please click on Play button. 

 

 
 

A date and time dialog box shows up. Please use  for entering date and time.  Press ENT 

button for searching the video.  Press ESC to exit the dialog box and press ESC again to exit 

playback dialog box.  For operating playback features, please follow the following: 

 

Pause: Press PAUSE button during playing video can pause the video in pause mode.   

Play: Replay the video after Pause, Fast Forward, or Fast Rewind. 

Fast Forward: Fast Forward the playback video. 

Fast rewind: Fast Rewind the playback video.  

Stop: Stop the playback video and return to playback menu. 

  

Select various split display modes on live and playback monitoring. 
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Chapter 9.  eMap Manager 

eMap is an application which can manage devices such as IP camera, IP 

Fast Dome, and DVRs/NVR on multiple maps.  With eMap, user can easily 

locate a particular device on a map.     

 

Chapter 9-1.  Before Accessing eMap 

Before accessing eMap, terms and screen layout are described in the following section: 

 

 

 

 

 

 

  

Find Device Panel 

To find a device, please click on Find Device Panel button or View->Device menu.  

Click on the device in Find Device Panel.   

 

 

Alarm Snapshot Camera with Camera View Multiple Live Video Map Representation 

Alarm Snapshot Device Tree 
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PTZ Control Panel 

To control PTZ device, please double click on a PTZ device.  Perform 

PTZ feature on the PTZ control panel. 

 

 

 

Chapter 9-2.  Tool Bar 

The buttons from left to right are described as follows: 

 

 

New map: Create a new map. 

 

 

Find device panel: Switch to Find Device panel 

 

 

PTZ control panel: Switch to PTZ control panel. 

 

 

Refresh: Refresh eMap map list and device information.  

 

 

eMap edit mode: Drag a device on a map for its position. 

 

 

Camera view control: Clockwise and counter-clockwise rotate a camera view. 

 

 

Device list panel: Switch to device list panel. 

 

 
Find alarm panel: Switch to find device panel. 

 

PTZ control panel: Switch to PTZ control panel. 

 

 
eMap alarm mode: Receive alarm mode. 

 
eMap control mode: for PTZ control and live monitoring mode 
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Chapter 9-3.  eMap Alarm Options 

 

Chapter 9-3-1.  Setup a Map 

To setup a device map, click on File->New Map or New button at Map list.  A file opening dialog 

box gets displayed.  Please select the JPEG map file representing the installation site.  Type 

both map name and location information. 

 

 

 

 

To delete a map, please first select the map in Map List and click on File->Delete Map or click on 

Delete button.   

 

 

To access property of the page, click on Property button. 

 

 

 

Chapter 9-4.  Setup a Device on a Map 

To setup devices on a map, drag-and-drop a device from Device List to its associated 

map.  The device item shows checked if the device is setup on the map.  
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Chapter 9-4-1.  Delete a Device on a Map 

To delete the device on the map, follow the following steps: 

  

1. Select on the device. 

2. Right click on the device. 

3. Select “Device Delete” menu item. 

 

Or, uncheck the check box of the device item. 

 

Chapter 9-4-2.  Arrange a Device 

To arrange the device position on the map, click on Drag Mode tool or menu item to 

enable device drag mode.  Use mouse point drag the device to the destination 

area.     

 

Chapter 9-4-3.  Device Property  

To show a Device Property, select “Device Property” menu item on 

the menu.  A Device Property dialog box shows up.  Device name 

and device text color can be changed for distinguishing its 

background image.   
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A camera view control can indicate a camera’s viewing angle.  To setup camera view control, 

please click on the clockwise/counter-clockwise control to rotate camera viewing angle. 

 

 

 

Chapter 9-5.  Find a Device on eMap 

DVR, DVR’s camera, or IP-based devices can be setup on 

different maps.  It is very difficult for a user to find the live 

video of a particular device.  To find a device on eMap 

instantly, a user can click on Find Device Panel 

button/View->Find menu item.  List of all devices in Find 

Device Panel can be found on a map instantly.  The user 

can click on the device that eMap can automatically switch to 

the map and show the device and its live video. 
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Chapter 10.  Web Server 

Each CMX has one web server for displaying live video.  To enable the service, please specify 

the port number of the PC’s IP address.   

 

Once this is done, the user can click on the HTTP Link and launch Internet browser to see the 

video.   

 

Chapter 10-1.  Login Web Server 

To login CMX web server, please provide the username and password for the service.  The live 

video is grouped based on grouping as in CMX Software HD 3.6.  Once a grouping is managed, 

the grouping can be assigned for its access right of a user.  Please see grouping section for 

detail.   
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Chapter 11.  Database Manager 

Database Manager allows a user to perform operational report printing, 

event report printing, database importing, database exporting, and 

database repairing.   

 

To perform above features, please see the following: 

 

 

 

Chapter 11-1.  User Operational Report 

For showing all logon logs, please click on “User Log Report” menu item.  To print out 

the report, please click on “Print/Print Preview” menu item.  

 

Chapter 11-2.  Event Report 

For showing all alarm event logs, please click on “Event Report” menu item.  To print 

out the report, please click on “Print/Print Preview” menu item. 

 

Chapter 11-3.  Database Maintenance 

Database maintenance is constantly required.  To perform database maintenance, 

please click on Tool->Compact DB or click on Compact DB tool button. 

 

Chapter 11-4.  Import Database 

Database configuration can be imported from a XML configuration file.  To import 

database, please click on Import Database button.   

 

Chapter 11-5.  Export Database 

Database configuration can be export to a XML file for later use.  To perform 

exporting, please click on Export Database button. 
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Chapter 12.  Setup Multiple Monitors  

Multiple monitors support is a feature in Windows XP or higher.  Multiple monitors support 

allows you to expand the display across for both CMX Software HD 3.6 and eMap.   

 

The benefit of adopting multiple monitors support is to 

use one mouse/keyboard to control both CMX Software 

HD 3.6 and eMap.  Multiple camera view in CMX 

Software HD 3.6 and live video in eMap can be 

operated by an operator on a personal computer.  

 

To install additional monitors, you must first install the 

compatible video adapter hardware into the PC and 

connect the additional monitor.   To setup multiple 

monitors support, read the instruction manual of 

Windows XP. 

 

Chapter 12-1.  Multiple Monitors Virtual Matrix Output  

CMX can up to support 6 monitors, one main monitor + 5 additional monitors.  CMX TV wall 

virtual matrix can be connected as the system described below: To support 6 monitor outputs, 

please use ASUS 7970-DC2-3GD5 graphics card.  

 

After installing the graphics card, click on Monitor button. It shows all the detected 

monitors shown below:  
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Once all the monitors are properly installed, click on "Identify Monitor". All monitors are shown 

IDs as below: 

 

 

Few functions for controlling CMX monitors are described below:  

 

 Quad display: for large LCD panel, CMX can be configured to show 4 CMX monitors on 

one big LCD monitor.  Each monitor can be 36-windows display. 

 Default grouping: the default grouping to be shown on the main monitor.  

 Sequence time: the monitor can be programmed for sequence display.  

 Division: the default camera division of the grouping.  

 Low CPU usage mode: this mode can only display I frame for reducing CPU time. 
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Chapter 13.  Retail and Distribution Business Solutions 

CMX Software HD 3.6 is able to connect to Point of Sale (POS) terminals.  POS transaction 

data can be captured by CMX Software HD 3.6.  POS transaction data can be displayed on live 

video and playback video.  CMX Software HD 3.6 also provides smart transaction search for 

associated video clips.  To perform these features, please follow the steps below: 

 

Chapter 13-1.  POS Connection Basis for Retail Business 

CMX Software HD 3.6 basically listens to the ASCII/COM output of a POS system via RS-232.  

Please check POS’s display output or printer output for ASCII data of your POS system.  

Please consult your POS provider for more detail.    

 

 

 

Basically, please connect RX/TX of the RS-232 of a POS register/terminal to CMX PC.  Please 

see wiring diagram below: 

 

To connect more than one POS terminals, add more RS-232/COM port into the CMX PC. 
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Chapter 13-2.  POS Connection via TCP/IP for Retail Business 

Using CYT-100SC RS-232 to TCP/IP converter, CMX allows receiving RS-232 of POS 

transactions via TCP/IP.  The product CD of CYT-100SC has one virtual driver which can map 

the TCP/IP transactions to a virtual COM port.  The virtual COM port can been accessed via 

Windows OS.  Once the virtual COM port is setup, follow the following sections for the setup. 

   

 
Chapter 13-3.  Test POS Communication with a PC 

After the POS connects to the CMX PC, please use Hyper Terminal or other RS-232 capturing 

application to test and to verify POS data that can be captured in the CMX PC.   

 

Chapter 13-4.  Link POS with a Channel 

To link a POS to a camera, please click on “Property” button and “POS” button.  The 

POS Setting dialog box shows up.   
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In POS Setting dialog box, please specify the following information for capturing POS 

transactions. 

(1) Device: POS register number. 

(2) COM Port: The mapped COM port number for the POS terminal. 

(3) Print on Video File: Record POS transaction into video file. 

(4) Print on Playback: Display POS transaction during playback. 

(5) Print on POS Live: Display POS transaction at live video. 

(6) Text Alignment: Alignment of POS transaction. 

 

 

 

Once above information is setup correctly, CMX Software HD 3.6 starts to capture and to display 

POS transactions on live video.  
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Chapter 13-5.  Playback with POS Transactions 

During playback, the recorded POS transactions get shown on the video and displayed on the 

list box.  Click on a POS transaction.  The video clip is played associated with the time of the 

POS transaction.     

 

Chapter 13-6.  Search POS Transactions 

To search a particular search conditions such as an amount, a product item, subtotal, and total, a 

user can set the search condition for associated time stamp.  Click on the item in the listbox.  It 

Note: For demo purpose, please press F3 to show simulated POS transitions. 
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can play the video of the transaction.  

 

Chapter 13-7.  Scanner Connection Basis for Transportation Business 

For transportation business, a barcode scanner and a keyboard are widely used.  The barcode 

scanner for scanning barcode is connected to a PC via the PS/2 connector of the CMX PC.  

The barcode scanner acts as a keyboard.  In CMX Software HD 3.6, the scanner connection 

only accepts 0 to 9 for keyboard scanner or the barcode scanner.   

 

To use barcode scanner as transaction device, connect barcode scanner into PS/2 connector.  

In “Camera Settings” dialog box, enable “barcode scanner” option.  For one PC, there is only 

one video channel that can be set for the barcode scanner. 

 

For search barcode transactions and playback on the barcode transaction, please see “Playback 

with POS Transactions” and “Search POS Transactions” for detail. 
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Chapter 14.  Mobile phone support 

Chapter 14-1.  iPhone and iPad support 

Please use your iPhone and select AppStore for download Live Cams Pro application developed 

by Eggman Technologies. Execute Live Cams Pro application. Please click on “Add Camera” 

button on your phone while using Live Cams Pro. Task bar gets prompted as below: 

 

 

 

Please select one of the following cameras or DVR/NVRs' type： LILIN NVR: 

NVR104/108/116/CMX driver. Please provide the following information:  

1. Name: IP Camera or DVR/NVR’s camera name  

2. Host or IP: IP address or DNS address  

3. Port: Port number  

4. Provide username and password information. For IP camera, the default username and 

password are “admin” and “pass”. For DVR/NVR, the default username and password are 

“admin” and “1111”.  

 

Once above information is entered, please click “Save” button. You are able to see live video of 

the IP camera or DVR/NVR’s camera. 

 

 



- 55 - 

Chapter 14-2.  Android Support 

Please use your Android phone and select Android Market for download Live Cam Viewer 

application developed by Robert Chou. 

 

  

Execute Live Cam Viewer application.  Please click on Setup button on your phone while using 

Live Cam Viewer.  Task bar gets prompted as below: 

 

 

Please click on Manage Cameras button.  A list of camera names shows on the screen.  

Please select one of the cameras and click on Edit button.  

 

 

“Add/Edit IP Camera” dialog box gets prompted for editing of an IP camera or a DVR. 
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In “Add/Edit IP Camera” dialog box, please enter the following information: 

 

1. Name: Name of the IP camera or DVR’s camera 

2. Category: Please select Merit LILIN. 

3. Type: Select device type, Merit LILIN D1/Merit LILIN HD/Merit LILIN DVR. 

4. IP Address: Please type IP address, for example http://59.124.49.36:60005 where 

60005 is the port number. 

5. Provide username and password information.  For IP camera, the default username 

and password are “admin” and “pass”.  For DVR, the default username and password 

are “admin” and “1111”. 

 

Once above information is entered, please click “Save” button.  You are able to see live video of 

the IP camera or DVR’s camera.  

 

http://59.124.49.36:60005/
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Chapter 15.  CMX Streaming Client & Server 
CMX provides client and server architecture where a CMX server can stream video to a CMX 

client.  This can further reduce CPU loading from an IP camera.  The system architecture is 

described below: 

 

Chapter 15-1.  CMX Streaming Server 

To enable CMX streaming, click on System Setting button and enable Network tab.  

Check Streaming Server opton and specify the Listen Port number.    

 

Once the streaming server is enabled, a proxy program is activated if CMX is launched.  Please 

do not close CMX Streaming Server proxy program, if remote live monitoring from CMX server is 

required. 
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Chapter 15-2.  CMX Streaming Client 

To enable live monitoring from a CMX server, click on Properties button.  Select CMX 

Live Streaming driver.  Provide IP address and port number of CMX streaming server.   

 

Due to bandwidth management, SD streaming and HD streaming can be selected.  If the 

bandwidth is very low such as Internet, Low Bitrate mode can be selected. 
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Chapter 16.  CMX ANPR Plug-In 
CMX automatic number plate recognition (ANPR) is a plug-in of the USB license dongle which 

allows CMX to perform ANPR feature.  Features such as white list, black list, and exclusion list 

are supported in CMX.  For more detail, read LILIN CMX ANPR manual for detail.   
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Chapter 17.  Trouble Shooting 

Chapter 17-1.  What should I do if I experience video flickering in CMX 

If you experience video flickering at CMX of the PC’s graphic card, please follow the instruction 

for solving the problem.         

 

Step 1: Please go to “Control Panel->System and Maintenance->System Properties” at 

Windows 7. 

 

 

Step 2: Click on “Performance Setting” button and select “Adjust for best performance” option.  

It can solve the flickering problem. 
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APPENDIX 

System Requirement 

OS:     Windows XP Home, Windows Vista Home, SP3 required, Windows 7 Home 

CPU:     Minimum Intel Duo CPU 2.0 GHz or above 

RAM:   4 GB DRAM or above 

HDD Size:    At least 250 GB for recording storage 

Network:      Gigabit network  

 

Product Supported 

iMEGAPRO Series:  IPR733, IPR434, IPR742, IPR742, IPR722S, IPD320ESX,  
IPG1022, IPG1052, IPD2220, IPD2322, IPD6122,IPR6122,  

L Series:    LB1022, LD2122, LD2222, LD2322, LD6122, LR6122,  

LR7022 
H.264 D1 IP Camera:  IPS203/IPS212, IPS025/030/035, IPS125/130/135, IPR454X 

H.264 HD IP Camera:  IPR31ESX, IPD112ESX, IPG012ES, IPR414ES, 
IPR614ES,  

IPR712S, IPD012 
H.264 1.3 MP IP Camera:IPR31MX, IPR712M,  

Video Server:   VS012 
DVR/NVR:    PDR-400IP, DVR304, DVR308, DVR316, DVR508, DVR516,  

NVR104, NVR109, NVR116, NVR404C 

 

Username and password 

Default username and password for various devices are described as in the table: 

Device Admin Admin pass. Oper Oper pass. Guest Guest pass. 

IP Cameras admin pass None None guest guest 

DVR/NVR admin 1111 None None guest 2222 

CMX Software admin EMPTY operator EMPTY guest EMPTY 

 

Benchmark Environment: 

PC network card—Gigabit network card 

Gigabit hub * 1 
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Hardware Accessory Support List 

Graphics Card for Supporting 6 Monitors:  

ASUS 7970-DC2-3GD5 is tested and verified for support 6 monitors virtual matrix output. 

 

USB to RS-232/RS-485 for LILIN PIH-931D Keyboard or RS-232 POS 

Merit LILIN PMH-RS485/USB 

 

RS-232 to TCP/IP for RS-232 Access Control, PIH-931D Keyboard, and RS-232 POS. 

CYT-100SC RS485/RS232 to TCP/IP Converter 

 

Ethernet Digital Remote I/O 

ioLogik E1210, E1211, E1212, E1214  

 

Ethernet Cash Drawer 

APG-480/APG-490 
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H.264 benchmark table 

Intel Core i7-2630QM 2.00GHz RAM: 8 GB DDR III, OS: Windows 7, 64 bit 

H.264 1080P (1920 * 1080) at 30 FPS 

Channel CPU Usage 

2 25% 

4 30% 

6 40% 

8 50% 

10 65% 

12 75% 

14 Overloading 

16 Overloading 

18 Overloading 

20 Overloading 

22 Overloading 

24 Overloading 

26 Overloading 

28 Overloading 

30 Overloading 

32 Overloading 

34 Overloading 

36 Overloading 

 

CPU model: Intel i7 Quad-Core 2.93GHZ RAM: 2 GB DDR III, OS: Windows 7, 64 bit, SP1 

H.264 D1 (720X480) at 30 FPS H.264 720P (1280X768) at 15 FPS 

Channel CPU Usage Channel CPU Usage 

2 1% 2 3% 

4 2% 4 3% 

6 3% 6 9% 

8 5% 8 19% 

10 9% 10 21% 

12 9% 12 26% 

14 9% 14 28% 

16 9% 16 35% 
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18 9% 18 50% 

20 11% 20 77% 

22 12% 22 84% 

24 17% 24 85% 

26 20% 26 85% 

28 24% 28 100% 

30 25% 30 Overloading 

32 31% 32 Overloading 

34 40% 34 Overloading 

36 48% 36 Overloading 

 

CPU model: Intel T5750, 2GHZ DuoCore, RAM: 3 GB DDR II 677, OS: Windows XP SP3 

H.264 D1 (720X480) at 30 FPS H.264 720P (1280X768) at 15 FPS 

Channels CPU Usage Channels CPU Usage 

2 22% 2 15% 

4 41% 4 34% 

6 55% 6 37% 

8 63% 8 55% 

10 80% 10 64% 

12 87% 12 84% 

14 94% 14 100% 

16 100% 16 Overloading 

18 Overloading 18 Overloading 

20 Overloading 20 Overloading 

22 Overloading 22 Overloading 

24 Overloading 24 Overloading 

26 Overloading 26 Overloading 

28 Overloading 28 Overloading 

30 Overloading 30 Overloading 

32 Overloading 32 Overloading 

34 Overloading 34 Overloading 

36 Overloading 36 Overloading 



- 65 - 

CMX 3.6 HD Software Specification 

Recording Schedule / Motion detection / Manual recording 

   Live  Up to 72 channel after registration 

   Speed Up to 1080P 30 FPS and ROI recording supported 

   Resolution Max 5MP 12 FPS, 3MP 15 FPS, 2MP at 30 FPS, and ROI recording supported   

   Schedule 7 day * 24 hrs time table, recording mode configurable 

   Alarm recording Face detection, audio detection, tampering, motion, DI alarm detection 

Playback Time search, event search, date search, POS SmartSearch, and motion SmartSearch 

   Speed FR: 2x, 4x, 8x, 16X 32X / FF: 2x, 4x, 8x, 16X, 32X 

   Compression H.264 / JPEG 

   Search Date, time, event, POS SmartSearch, motion SmartSearch, plate search (optional) 

Video Input LILIN IP camera, LILIN IP speed dome, LIIN DVR/NVR, CMX live server 

   Camera name 20 characters  

   Channel editing Mouse drag-n-drop 

   Digital zoom Yes, ePTZ supported 

   Grouping User grouping authentication assignable for eMap, and CMX Software HD 3.6 

Multiplexer Sequence  

   Split screen 4, 9, 16, 36 

Alarm  

   Alarm management PC sound, redirect IP camera DO, eMail snapshots, redirect a PTZ preset recall 

   Event Various alarm log, video loss, stop recording, schedule, logon, operation log 

   Digital output Controllable 

Accessories  

   P/T/Z protocol LILIN PTZ controllable via HTTP 

   Audio PCM/G.711, two-way audio, audio recording 

   POS/barcode Scan RS-232/PS/2 

   Keyboard PIH-931D keyboard controllable via RS-485 for PTZ, ePTZ, and ROI features  

eMap  

   eMap live monitoring One channel for IP camera/multi-channel for DVR 

   eMap snapshot Yes 

   PTZ control Yes 

DB Manager  

    Database  Database configuration import, export, report, and maintenance 

Remote Access  

    Remote CMX Live video Multiple channels of HD, SD, and low bitrate modes supported 

    Remote DVR/NVR video Multiple channels of DVR/NVR supported 

Backup  

    CMX/DVR/NVR DVR remote backup, AVI conversion and JPEG snapshots 

    Remote backup Multiple channels remote backup supported 

Management  

    Access log Complete access log in database manager 

    User management User authentication: three level: admin, operator, and guest, features configurable 

    Recording calculator Yes, dynamically calculating available recording days 

    Video archiving Yes 

Network  

    Web interface Live web interface 

    Mobile support iPhone and Android 

    Protocols ARP / TCP/IP / HTTP / SMTP / DNS / PPPoE 

    IPScan Supported, easy-to-setup for IP address 

Other  

    DST Daylight saving time by Windows OS 

    OS Windows 7 Home, Windows Vista Home, and Windows XP Home 

    Language 
English, Chinese, Spanish, French, Italian, Japanese, Russian, Portuguese, Simplified 

Chinese, Czech, Slovene, German, and Hungarian 

    CPU requirement Minimum Intel Duo CPU 2.0 GHz or above 

    RAM requirement 4GB memory 
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